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Operating Instructions for the ELIT ISE/pH Ion Analyser 
First public version: CCR/HK/YYC/11 Oct. 2004.    Last Update: 04 April 2016 

 
Please see separate Electrode Operating Instructions for how to use Ion Selective Electrodes 
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A) INTRODUCTION 
 
This system can be used with any pH, Ion-Selective, or Redox electrode and any 
computer with Microsoft Windows operating system – Including Win 10.  
 
If Redox electrodes are to be used then no calibration is required and the Redox 
potential is read from the millivolt display on the pH Measurement module.  
 
B) SOFTWARE INSTALLATION 
 
1) System Requirements 
 
Important: This software must be run on the Windows' English platform, which uses a 
Decimal Point instead of a Comma to separate the decimals.  If the computer has been 
setup for using a non-English platform, please change the Language to English (United 
Kingdom) in  "Regional and Language Options 
Please turn to last page of this document for detailed specifications. 
 
2) Running Setup 
Insert the software disc into the CD-ROM drive of your computer.  
The installation (Setup) software should then run automatically - simply follow the on-
screen instructions. If the installation fails to start when you insert the CD, go to My 
Computer and double Click CD-ROM disc (Usually the D drive unless a second hard 
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drive is installed) or Click on Start and then Run D:\Setup.exe, then follow the on screen 
instructions. The running executable file for the 32 bit version is: iseph32.exe.  
When installation is completed you will be given the option to create a new icon on your 
desktop. Double clicking on this will start the programme.  
 
C) HARDWARE INSTALLATION 
 
Connect the Analyser/computer interface to a Serial port of the computer using the 
cable provided.   Connect the mains adapter to the interface and to an appropriate 
power outlet. 

For computers with no Serial port, a Serial/USB  converter is included with the 
hardware.  This must be installed according to the instructions in the appendix at 
the end of this document before the analyser is connected to the system. 

If you are using ELIT 8 mm electrodes, with the ISE and reference electrode both 
housed in an ELIT Electrode Head, or a combination pH electrode, then you only need 
to connect the BNC plug(s) attached.  
 
If you wish to use a separate conventional reference electrode then this must be 
plugged in to the 2 mm jack-plug socket labelled R  
pH and Redox electrodes can be used in either channel but the ISE only in channel 1.  
 
If pH and ISE are required simultaneously in the same solution then no separate 
reference electrode is required because the ISE voltage will be measured relative to the 
internal reference system of the pH electrode. But note that pH electrodes generally 
cause a slight contamination of the test solution with K, Cl, and traces of Ag because of 
slow leakage of the filling solution through the liquid junction. Thus simultaneous pH 
measurement may cause anomalous high readings in the measurement of low 
concentrations of ions for which K, Cl or Ag is a significant interfering factor: e.g. K, Cl, 
Ag, NH4, NO3, Cd,  
 
Two temperature probes can be connected to the jack plug sockets labelled T. When 
two pH electrodes are in use both temperature sensors are active - to monitor changes 
in two vessels but if pH is being used in conjunction with an ISE then only temperature 
probe number 1 is active. 
 
 
 
 
D) SOFTWARE OPERATION 
NB: There are Help texts and drop-down warnings available on almost every screen to 
guide the operator reliably throughout the operation of this software. The Back button is 
used universally to leave any screen and move to another option. Clicking on Exit will 
cause a complete shutdown of the application and a return to Windows Desktop (but 
you will be reminded to save any un-saved data before this happens). 
After the initial title screen, clicking on OK (single click), or pressing Enter will reveal the 
main introductory screen which gives you four options:  
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1) Hardware Setup. 
This screen allows you to enter all the details necessary for setting up your experiment / 
measuring system and producing a complete documentation for archiving and GLP 
procedures. You can record serial numbers for the electrodes, the type of reference 
electrode, the name of the operator and a comment about the use of ISAB or other 
aspects of the analysis.  
 

 
 
There is also an option to change the date format between American and European 
styles. Click with the mouse in the small boxes to select or de-select the electrodes and 
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temperature sensors you require.  If no temperature sensor is available then you can 
type in an appropriate default value - this can be changed later on in the program if 
necessary. For 1-Channel operation, be sure to de-select the pH electrode and 
temperature sensor in channel 2.  If you are using an ISE, then you must define here 
which ion is being analysed by selecting from the drop-down menu. 
 
2) Chemtools 
This package contains several functions and information to help the analyst design his 
experiment and perform various calculations. The on-screen text and Help files should 
provide sufficient information for operation. Use the Back button to move between 
different screens. 
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3) ISE Measurement 
 
Procedural Note: For the most accurate stable measurements with ISEs it is 
recommended to wait at least 2 minutes after the ISE is immersed in the sample 
or standard before taking a reading.  Low concentrations (below 1 ppm) may take 
up to 10 minutes to reach a completely stable reading. It is also useful to increase 
the "Average Number" (see later)  to 10 to 30, which means the system takes 10 
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to 30 measurements at 2 second intervals and displays the average of these 
measurements. This procedure reduces the influence of electromagnetic noise 
and chemical instabilities.  For fast measurements when highest precision is not 
required the waiting time and average number can be reduced. 
 
Clicking on the “ISE Measurement”  button reveals six more options: 
 
3a) ISE Introduction 
This text file gives more information about setting up your hardware and contains much 
useful advice to help you use your ISEs effectively. 
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3b) ISE Calibration 

 
 
The first screen allows you to enter the parameters for defining the axes of the 
calibration graph. These are millivolts for the y-axis and the logarithm of the molar 
concentration for the x-axis (the approximate ppm equivalent is given in brackets as a 
guide to the concentration range required). If there is any doubt, it is suggested that the 
widest range is selected initially, since the scales can be quickly changed once the 
graph is plotted. 
Note that these parameters are for the graphics display only. They have no effect on the 
accuracy or precision of the calculation of the sample concentrations. 
 
You must also select here how many calibration points you require. You can use only 
one if you know the slope of the electrode (which can be typed in later) but normally two 
are required (preferably spanning the range of concentrations of your samples) to define 
the slope in the linear range of the electrode and at least three are required in order to 
confirm the linearity of the calibration graph.  
 
The last choice is to select whether you want to use on-line or Keyboard Entry mode. 
 
The Option menu in the tool bar, allows you to change the Average Setting. This is the 
number of readings to be taken and averaged to produce the final value for the millivolts 
produced by each electrode. The higher the number of readings, the more stable and 
precise the measurement. The value displayed on the screen is the result of a 'gliding 
average' which produces a stable value which is the average of the specified number of 
readings but is updated as each new reading is taken. 
 
Once the calibration parameters have been entered, click OK to produce a data entry 
window.  
 
For on-line readings, there will be a short delay before the first millivolt reading appears. 
Thereafter there will be a continuous display in this box. The length of time taken to 
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reach a stable reading depends on the Average Setting and on the electrode 
characteristics.  
For Keyboard entry, you must type in the value for the millivolts. 
 
You must now type in the concentration of the first standard (normally use the most 
dilute first, then work up sequentially to minimise cross contamination).  
There are three boxes available for this, depending on which type of concentration units 
you wish to use; but whichever is used, the software will automatically fill in the other 
two options - remember to press Enter after each data entry. 
 
When all the boxes are complete, and the mV reading is seen to be stable, clicking on 
OK will record the data and move on to the next calibration point. Once calibration is 
completed you will immediately be presented with the calibration graph and details of 
the overall slope, and also the slope between individual points, so that you can assess 
the quality and linearity of the calibration.  
A small window will ask you if you wish to save this calibration (in a Windows file). If this 
obscures part of the graph, it can be easily moved by clicking and dragging on the title 
bar. Answering NO to this question will lose these data and send you forward to the 
Potentiometry screen where you can choose to open an old calibration file or re-do the 
calibration. 
 
3c) ISE Potentiometry 
Direct Potentiometry is the easiest, quickest and most widely used method of making 
ISE measurements. Simply measure the voltage in an unknown solution and compare it 
with that of a known standard by means of plotting on a calibration graph. 
For the most precise work the calibration should be made immediately before the 
samples are measured, in solutions of the same temperature as the samples. 
Nevertheless, approximate results can be obtained using old calibration data which may 
be good enough for some applications. 
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The Potentiometry/Measurement screen is the main working area for ISE 
measurements. Once a calibration line has been plotted, either from new data or from 
an old calibration file, the Option menu will allow you to change the type of line fitting 
and change the scales on the graph; but note that only the Linear Regression will 
allow you to measure samples which lie outside the range of the calibration data. 
Extrapolation is not recommended for the highest precision.  

 
 
If sample concentrations range over several orders of magnitude, the Partly Linear 
option, which uses the actual slopes between the individual points, will probably give the 
best results. Note that if you change the type of line-fitting or the scales during a series 
of sample measurements, the screen will be cleared of any plotted sample lines – but 
the data will remain in the data table.  
When the calibration graph is formatted to your satisfaction, sample measurement is 
started by clicking on Potentiometry in the tool bar. You can then select Keyboard 
Entry or OnLine Reading.  
If Keyboard is selected you can type the sample millivolts in the appropriate box shown 
by the cursor.  
For on-line measurements, a drop-down Data Reading window will continuously display 
the latest millivolt signal from the electrodes.  
The Options menu allows you to change the Average Setting.  
 
Before starting to make measurements you will be given the option to create a data file 
in which to permanently save the data as they are acquired. In addition, each time you 
take a reading, you will be prompted to type in a sample number/name and save the 
data in a temporary data table. This data table can be reviewed at any time by clicking 
on the Option menu. But note that you will have to Cancel the data reading window 
first, then restart measurements by clicking Potentiometry again. 
The File menu provides options for printing the current data table, the graphical display, 
and the calibration data, and for opening old data files for reviewing and printing. 
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If you do not initially choose to save the sample data whilst measuring, you will be 
reminded that the data table has not been saved and given the option to do so, before 
being allowed to quit the Measurement screen. 
 
3d) ISE Standard Addition 
The standard addition method involves adding a small volume of a concentrated 
standard to a much larger volume of sample and requires that both volumes are 
measured accurately and that the approximate concentration of the sample is known.  
It is more precise than direct potentiometry because there is little time delay between 
calibration and sample measurement and both measurements are made in essentially 
the same solution, so that temperature and ionic strength differences are not significant. 
Furthermore, because the electrodes remain immersed in the same solution throughout 
the measurement, there is far less opportunity for a change in the reference electrode 
Liquid Junction Potential than in normal potentiometry where the LJP can vary by 
several millivolts when the electrodes are re-immersed in a different solution.  
This method is generally more time consuming and requires more complex calculations 
but, nevertheless, is made relatively quick and easy with this software.  
 
After initially determining the approximate concentration of a sample using 
potentiometry with an old calibration file, the precise slope of the calibration can be 
found using two standards closely spanning the sample concentration. Alternatively, for 
less precise work, the original electrode slope can be typed in.  
 
The Standard Addition option allows you to type in the volume and expected 
concentration of the sample and will then suggest what volume of what concentration 
standard should be added. If only a different concentration standard is available, then 
this can be entered and the software will calculate what volume of this to add. Finally, if 
this volume is inconvenient, then the nearest convenient volume can be entered and the 
final calculation will be based on this. 

 
Remember to press Enter after typing in any data to make a permanent record and 
activate any accompanying calculations. 
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When all the data boxes are completed, including temperature of calibration and of 
sample, the data entry procedure is similar to that for direct potentiometry.  
For Keyboard Entry, first enter the data for the sample alone, then for the sample plus 
standard. For On-line Reading, first measure the voltage in the known volume of pure 
sample then add the standard, mix thoroughly, wait for a stable reading and re-
measure.  
Once both the millivolt boxes are filled, clicking on the Calculate button will display the 
result and a short comment describing the quality of the determination. These data can 
be saved in a table and a permanent file, along with a sample number and a short 
comment, and old data files can be reviewed and printed.  
 
Double clicking the On-Line Reading box will re-activate the measurement window 
ready for another sample (using the same settings for volumes and concentrations etc). 
Clicking File/New will clear the data boxes ready for a completely different sample.  
For maximum accuracy, the calibration may be "fine tuned" by measuring a sample of 
known concentration which lies within the range of the normal samples (e.g. a separate 
dilution of the standard) and typing in various values for the slope (and re-clicking 
"Calculate") until the measured concentration is correct. Then use this slope for 
subsequent sample measurements. 
 
3e) ISE Sample Addition 
The sample addition method has all the advantages of standard addition and is used in 
exactly the same way, except that a small volume of sample is added to a larger volume 
of standard. It is most useful when only small amounts of sample are available, or for 
highly concentrated samples. The on-screen display is very similar to that for Standard 
Addition (above). 
 
3f) ISE Continuous Recording. 
This option provides a graphical display of the ISE measurement in real time, with 
sequential readings taken automatically. The display shows the ppm value (y-axis) 
plotted against time (data number). At the top of the screen, a row of data boxes show 
the Interval time, Elapsed Time, Data Number and ppm of the current reading. The real 
time of starting is displayed in the title bar. All the data, including the real time for each 
measurement, is recorded in the data table which can be saved, reviewed, and printed 
in the same way as data from manually acquired potentiometric measurements. 
 
The first screen allows you to elect to open an old file for reviewing, or start a new data 
recording. When viewing an old (or recently completed) file, the data for a particular 
point will be displayed after typing the data number in the appropriate box. 
If there is not already a calibration file for the ion to be measured, then you will be 
warned that this is necessary and you cannot proceed further without first making a 
Calibration. 
 
In order to start a new recording you must first choose the Measuring Interval (2 secs. to 
30 mins.) and Monitoring Period (40 secs. to 4 days) but note that these parameters are 
linked, i.e. the higher the Interval the longer the Period (in order to limit the total number 
of data points recorded; maximum = 200). You must also select here the ppm range for 
the graph. 
 
The Option menu allows you to Change the y-axis scale and the Average Setting or 
View Data Table.  
Clicking on OK starts the recording and display of the data.  
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4) pH Measurement 
Clicking on pH Measurement reveals four more options: 

 
 
4a) pH Introduction 
This introductory text gives much helpful advice on setting up and looking after the 
hardware, hints on how to make good pH measurements, and trouble-shooting. 
 
4b) pH Calibration 
The first calibration screen allows you to choose to calibrate either or both channels 
(depending on the Hardware Setup) and how many buffer solutions you wish to use 
(minimum 2, maximum 4). You can also use the Option menu to change the Average 
Setting (see section 3b) if you want to increase the precision of measurement.  
Clicking on OK leads you to the data entry window. 
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After a short delay, the mV box will continuously display the signal from the appropriate 
electrode (electrode number shown in the title bar). You must then type in the pH value 
of the buffer (press Enter), immerse the electrode in the solution, and wait for a stable 
millivolt reading. When this has been achieved, clicking on OK will record the data and 
move on to repeat the process for the next buffer (and then the next electrode if 
appropriate). When all the buffer solutions have been measured, you can save this 
calibration using Windows SaveAs facility. Choosing not to save the calibration will lose 
the data and return you to the pH main menu.  
 
4c) pH Measurement 
The pH measurement screen has a simulated 2-channel pH meter display. After a short 
pause, it will continuously display the mV reading of the electrode in the appropriate 
channel (which can be read as the Redox potential if a Redox electrode is connected) 
and the pH based on the latest calibration data (latest means the last one that was 
saved). The details of the latest calibration and the current temperature are also 
displayed.  
 
Measurements are made by immersing the electrode in the sample solution, waiting for 
a stable reading, and clicking on SaveData in the tool bar. The first time you do this you 
will be asked to create a file name in which to save the data, and then you are 
presented with a data table in which you can type a sample name/number before 
returning to the measurement screen for the next sample. 



                                                ISE/pH Ion Analyser Operating Manual                                       Page 15 

 
 
The Option menu allows you to load a different calibration from a saved file (Change 
Calibration), change the Average Setting (for more precise measurement), switch on 
or off the Automatic Temperature Compensation in either channel (ATC), or View Data 
Table. The File menu can be used for Printing the current data table or Opening and 
reviewing old data files. 
 
4d) pH Continuous Recording 
This option provides a graphical display of the pH measurement of one or two 
electrodes, plotted against time (data number). The first screen allows you to elect to 
open an old file for reviewing, or start a new data recording.  
 
In order to start a new recording you must first choose the Measuring Interval (2 secs. 
to 30 mins.) and Monitoring Period (40 secs. to 4 days) but note that these parameters 
are linked, i.e. the higher the Interval the longer the Period (in order to limit the total 
number of data points recorded; maximum = 200). You must also select here the pH 
range for the graph and whether or not you want automatic temperature compensation.  
The Option menu allows you to Change Calibration and the Average Setting. 
Clicking on OK starts the recording and display of the data.  
 
The continuous display plots the two electrodes in different colours and displays the 
Interval time, Elapsed Time, Data Number and pH. The real time of starting is displayed 
in the title bar. All the data, including the real time for each measurement, is recorded in 
the data table which can be saved, reviewed, and printed in the same way as other data 
produced by this software. 
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 E) Exporting Data to other Software  
All data are stored in ASCII text format, which can be read by other programs such as 
MS Notepad and Excel. They are saved in the user-selected location(s) ( usually 
C:\Program Files\ISEpH32\ - unless a different folder was selected at installation) with 
user-selected file names, and the appropriate file extensions. 
*.TAB -- ISE Measurement - Potentiometry  
*.SMT -- ISE Measurement - Sample Addition Method  
*.SDT -- ISE Measurement - Standard Addition Method  
*.PHT -- pH Measurement - Measurement  
*.PHC -- pH Measurement - pH Continuous Recording 
For example:  
To read a *.TAB file from Notepad, launch Notepad, click File / Open and change the 
File type to "All Files" , then find the appropriate file and double-click on the name - or 
single click on the name and then click Open. 
To read a *.PHC file from Excel, launch Excel, and find the file as above. In this case, 
when you click Open; you will see the "Text Import Wizard" where you must select 
"Delimited" and then click on Finish.  
 
CAUTION: If you wish to save the data in another format please be sure to use the 
SaveAs facility to save with a different name or in a different folder - to avoid confusion 
and avoid corrupting the original data. 
 
 
SYSTEM REQUIREMENTS 
 
PC with 300 megahertz or higher processor clock speed recommended; 233 MHz 
minimum required (single or dual processor system), Intel Pentium/Celeron family, or 
AMD K6/Athlon/Duron family, or compatible processor recommended  
128 megabytes (MB) of RAM or higher recommended (64 MB minimum supported; may 
limit performance and some features)  
1.5 gigabytes (GB) of available hard disk space 
Super VGA (800 W 600) or higher-resolution video adapter and monitor  
CD-ROM or DVD drive  
One free COM port 
Keyboard and Microsoft Mouse or compatible pointing device 
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APPENDIX: 

 

Installation of USB to RS232 Serial Converter 
  

If your computer has a serial port, connect the Analyser (or other instrument) direct to this port 

without using the USB to RS232 converter. 

If your computer has no RS232 port, you have to use an USB port via a USB to RS232 

converter. 

  

To get the USB to RS232 conversion working properly, there is a standard procedure: 

  

1) Please note that the operating software is not supplied with the USB converter. The correct 

version for the type of converter you are using must be obtained from the Converter 

Manufacturer. The converter supplied with your Analyser uses the proven and reliable FTDI-

Chip from Future Technology Devices International Ltd.  

You can find more information on: http://www.ftdichip.com/ and download the driver free from: 

http://www.ftdichip.com/drivers/vcp.htm  

  

2) AFTER INSTALLING THE CORRECT DRIVER SOFTWARE, Connect the USB to RS232 

converter to your computer; this can be done while the computer is switched on. 

Only connect the USB to RS232 converter, not the Analyser. 

Usually a message comes up: "Found new hardware - USB.........- ready to use" 

  

3) Unfortunately the USB to RS232 converter software selects random COM numbers and 

usually not the COM 1 number, which we want for our Analyser / Instrument. 

We have to change the COM port number to 1 

  

4) The procedure for Windows 8, Win 7 and Vista is very similar: 

  

In the Start menu select Control Panel, click on Hardware and Sound, in Devices and Printers 

click on Device Manager. 

 

For Win. XP you need Control Panel / System / Hardware / Device Manager. 

Double click on Ports, "USB Serial Port (COM 4)" or any other COM number which comes up. 

Right mouse click on "USB Serial Port (COM 4)", a menu comes up: click on Properties. 

Click on Port Settings: it will show: 9600, 8, None, 1, None. Click on "Advanced", select COM 

1, neglect when it says (in use). 

When you click OK a warning appears: .........Do you want to continue? click Yes. 

Click OK and the Device Manager shows now: "USB Serial Port (COM 1)". You can test it by 

double clicking on it: 

The Device status says: "This device is working properly" 

  

6) Connect the Analyser / Instrument to the USB to RS232 converter. Make sure that in the 

Analyser / Instrument software also COM 1 is selected. 

 

http://www.ftdichip.com/
http://www.ftdichip.com/drivers/vcp.htm

